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LICENCE AGREEMENT 
 
IMPORTANT: By installing this software on your computer system, you accept the terms of this 
agreement. If you do not accept the terms of this agreement, do not install and return for a full 
refund. 
 
1. GRANT OF LICENSE: Thanhouser Company Film Preservation, Inc. grants you a nonexclusive license 
to use the enclosed software product, subject to the terms and restrictions of this License Agreement. You 
are receiving a license to use this software on a single CD drive, and Thanhouser Company Film 
Preservation, Inc. retains title to all such software. 
 
2. COPYRIGHT: The SOFTWARE is owned by Thanhouser Company Film Preservation, Inc. or its 
suppliers and is protected by United States copyright laws and international treaty provisions. The TEXT 
on the CD-ROM is owned by the author, Q. David Bowers.  Therefore, you must treat the SOFTWARE 
and TEXT like any other copyrighted materials (e.g., a book or musical recording).   
 
3. OTHER RESTRICTIONS: You may not modify, rent or lease the SOFTWARE. You may transfer the 
SOFTWARE and accompanying written materials on a permanent basis provided you retain no copies and 
the recipient agrees to the terms of this Agreement. Portions of the  TEXT may be used for non-commercial 
research and publications with the requirement that credit to the author Q. David Bowers is included for 
each usage of such text. 
 
4. LIMITATIONS ON LIABILITY: Thanhouser Company Film Preservation, Inc. warrants that the CD-
ROM disk on which this software is recorded is free from defects in material and workmanship, under 
normal use for ninety (90) days after the date of original purchase. If a defect occurs during the 90-day 
period, you may return the disk to Thanhouser Company Film Preservation, Inc. The remedy for breach of 
this warranty shall be limited to replacement and shall not encompass any other damages, including but not 
limited to loss of profit and special, incidental, or other similar claims. 
 
The SOFTWARE is licensed and delivered on an "as is" basis. Except for the express warranty set forth 
above, Thanhouser Company Film Preservation, Inc. makes no other warranties, either expressed or 
implied, by statute or otherwise, regarding the enclosed computer software product, its quality, its 
performance, its merchantability, or its fitness for any particular purpose.  This license is for a single user 
only. You may not use the SOFTWARE on any network, file server, virtual disk, timesharing, multiple 
CPU, or other multi-user, bulletin board, world-wide web server,  or remotely accessible arrangement. 
 
For further information, contact: 
  Thanhouser Company Film Preservation, Inc. 

8770 NW Kearney Street 
Portland, Oregon USA 972229 
e-mail: feedback@thanhouser.org  
www.thanhouser.org 
FAX: (503) 226-7961                11/04 
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ABOUT THE THANHOUSER FILMS CD-ROM 
Welcome to Thanhouser Films: An Encyclopedia and History, a comprehensive examination of the 
pioneering independent film company which flourished in New Rochelle, New York in the early part of the 
20th Century. We believe you will find this CD-ROM to be an ideal reference work for the study of any 
number of subjects related to early films, from the day-to-day operating of a film company, to an 
examination of the media coverage of the early film industry, to the technical aspects of the cinema in its 
early days, to the biographies of a large number of personalities who were associated with the Thanhouser 
Company. 
 
Thanhouser Films: An Encyclopedia and History encompasses the painstaking research of Q. David 
Bowers, who has compiled the narrative history of the Thanhouser Company as well as a complete catalog 
of Thanhouser films and the biographies of the many actors, directors, scenarists, and technicians who 
created the films. Additional sections of the CD-ROM offer hundreds of high resolution still photos, film 
clips, and a selection of posters used to promote the films. The CD-ROM itself is the work of a group of 
dedicated people who hope that you will find the Thanhouser data presented here to be not only of use but a 
pleasure to access. 
 
Contents of the CD-ROM 
When installed, the Thanhouser Films CD-ROM consists of four programs: 

♦ Thanhouser Films—Q. David Bowers’ encyclopedic effort documenting the history of the 
Thanhouser film enterprise from 1909 through 1918. 

♦ Τhanhouser Images—429 high resolution .TIF format black and white photographs and images 
with searchable captions. 

♦ Thanhouser Clips—32 Thanhouser silent film clips in .AVI format. 
♦ Thanhouser Posters—19 high resolution .BMP format color images of Thanhouser posters.  
 

INSTALLATION AND REMOVAL 
Installing Thanhouser Films CD-ROM 
The Thanhouser Films CD-ROM installation requires an IBM or compatible personal computer with a 486 
or higher CPU with CD-ROM drive and at least 8 MB of memory, 13 MB of free hard disk space, plus 
Windows 95, 98, Me, NT, 2000, or XP. 

1. Start your computer and CD-ROM drive. 
2. Insert the Thanhouser Films CD-ROM into the CD-ROM drive. 
3. Follow the onscreen instructions. 

If the installation does not automatically begin: 
• From the Windows taskbar, click START, and then choose RUN 
• In the RUN dialog box, type D:\setup.exe, where D is the name of your CD-ROM drive. 
• Click OK, and follow the onscreen instructions.  

Setup will install a Windows Group named "Thanhouser Company" with five programs: 
• Thanhouser Films   •      Thanhouser Clips 
• Thanhouser Images   •      Thanhouser Posters 
• Uninstall Thanhouser Films 

The next time you want to start the Thanhouser Films CD-ROM, just double click “Thanhouser Films” icon 
on the desktop or from the Programs menu in the Thanhouser Compay programs group. 
 
Display Configuration 
The Thanhouser Company CD-ROM is designed to run best with the display resolution set to 800x600 with 
256 colors or higher. Consult your PC documentation for details on how to configure your display for 
optimum performance. 
 
Uninstalling Thanhouser Films CD-ROM 
There are two ways to remove the Thanhouser Company programs from your system: 

1. From the Start Menu Programs select “Thanhouser Company” group and select “Uninstall 
Thanhouser Films”. 

2. You may also remove the software by selecting the Settings command in the Start Menu, select 
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“Control Pannel”, select the “Add/Remove Programs” icon, and then select “Thanhouser Films” 
and click “Add/Remove”. 

 
RUNNNING THE THANHOUSER FILMS PROGRAM 
From the Thanhouser Company program group, select Thanhouser Films. You will be presented with the 
contents page. On this page, you have five items to select from to explore the book: 
 
Welcome to the Thanhouser Films CD-ROM 
This selection will provide  you with an overview to navigate around the book, introductory information 
about the book, including a forward by noted film historian Anthony Slide, credits, notes on style, and 
information about the author, research associate and CD-ROM development team. 
 
Volume I: Narrative History 
This volume contains the narrative history of the Thanhouser Company. It includes the early life of Edwin 
and Gertrude Thanhouser in the theater before they founded the film company, as well as reviews of films 
and the history of early film making. Included in this section are photographs and magazine advertisements 
from trade publications of the era. 
 
Throughout the narrative history, you will find an underlined “Notes” colored in green or blue (depending 
on your system configuration). These are footnotes embedded in the text which  can be accessed by 
clicking on them. A popup window will be displayed with the footnote; it will disappear when you click on 
any other text. 
 
Volume II: Filmography 
This volume contains a description of each film made by the Thanhouser Company, including release dates, 
working and foreign titles, advertisements, synopsis, and reviews. The films are arranged chronologically 
by the year in which they were produced. The alphabetical index on this page enables you to access each 
film by title. Included in this section are photographs and film clips from surviving Thanhouser 
productions. There is a direct link on the opening page for this volume to all of the film clips on the CD-
ROM . 
 
Volume III: Biographies 
This volume contains biographical sketches of Thanhouser personalities emphasizing the positions the 
individuals played in Thanhouser's history and development from the inception of the Thanhouser 
Company in 1909 until the end of the Thanhouser Film Corporation's activities in 1918.  The dates 
mentioned in the headings are dates for which the person is known to have been with Thanhouser, 
combined with dates for which Thanhouser films featuring the person were released. Titles listed for each 
person represent films in which a given individual is known to have participated.  
 
The alphabetical index on the contents page of this volume enables you to access each biography by name. 
There is also a direct link to all of the most important (three starred “***”) actors and actresses in this 
section. 
 
Appendix 
This section includes a bibliography, British and French release information, a list of surviving Thanhouser 
films, and an alphabetical list of actors who were associated with Majestic films, a sister company, from 
1912-1914.  

 
BROWSING THROUGH THANHOUSER FILMS 
Go To the Underlined Topic 
Throughout the Thanhouser Films section of this CD-ROM you will note that much of the text, including 
all tables of contents, is underlined and colored in green or blue (depending on your system). Each of these 
occurrences signals a "hot spot" which allows you to click your mouse on the topic and immediately jump 
to that topic.  A “topic” is the basic unit of information that may be printed, copied to the clipboard, or the 
result of a search request. 
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Let's use an example. If your CD-ROM has been installed and is operational, enter the Thanhouser Films 
section of the CD. Click on the Contents button at the upper left corner of the workspace if you are not at 
the Contents page already (You will always find yourself at the Contents page on entering a session.) Click 
on the topic Welcome to the Thanhouser Films CD-ROM. Now click on the topic Site Map of Thanhouser 
Films CD-ROM. 
 
You are now looking at a complete listing of the contents of the Thanhouser Films section of the CD. Each 
of the underlined topics in the tables of contents is a Go To hot spot, and you may move to any one of 
them. Try clicking on a topic. Each topic will lead you to a lower level table of contents. Click on another 
topic at this level. 
 
Notice the arrow buttons, >> and <<, at the top of the workspace. Clicking on these arrows allows you to 
move forward and backward within the sequence of topics you have selected.  Try moving forward a few 
topics by clicking >>. 
 
Now click on the History button. A dialog box will appear which lists all of the topic areas you have 
visited in your current session. Highlight one of these and either double-click on it or select the Go To at 
the right side of the box. You will immediately move to that topic. 
 
Next click on the Go Back button. This operates in a way similar to the History  button. It moves you 
immediately back to the topic you visited prior to the current topic. As you repeatedly click the Go Back 
button, you will continue to move backward through the list of topics in the order you visited them. 

 
BUTTONS AND MENUS 
Buttons  
The buttons above the workspace allow you to move and perform various functions. For detailed 
descriptions of the use of some of these buttons in more complex applications, see the Performing Searches 
section below. 
• Contents moves to the Table of Contents. 
• Index brings up the Index dialog box. This indicates the topics which are available within each index. 

Each volume of the book (Narrative History, Filmography, Biography) has a separate index associated 
with it. 

• Go Back returns to the last topic or section you have visited. 
• History brings up a dialog box which lists in order of use the topics and sections you have browsed 

through during your current session. The list holds up to 40 entries. In order to jump to an entry, 
highlight the entry you wish to jump to and double-click the entry, or select the Go To  button within 
the dialog box. 

• Search  brings up a dialog box which enables you to search through any or all of the volumes of the 
book for words or phrases. See Performing Searches below. 

• << and >> These buttons allow you to move forward (>>) or backward (<<) to display the next 
sequential topic within the current browse sequence. 

• Narrative jumps to the Narrative History volume of the book. 
• Filmography jumps to the Filmography volume of the book, including alphabetical index of over 

1,000 Thanhouser  films. 
• Biographies jumps to the Biographies volume of the book,  including alphabetical index of over 1,000 

Thanhouser employees. 
 
Menus  
The pulldown  menus at the top of the workspace allow you to perform several useful printing, editing, and 
annotating functions. For a more detailed discussion of how to use these functions, see the Performing 
Searches, Copying  a Topic, and Printing a Topic sections below. 
• File The primary use of this menu is to print a topic to a printer (Print Topic). It also enables you to 

specify and configure printers (Print Setup...). The Open... command enables you to open another 
Viewer file (.mvb).  

• Edit The Edit menu offers two useful functions:  
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Copy..., the ability to copy the current open topic into the Clipboard. This text can then be edited 
and/or pasted into a  file.  

Annotate..., the ability to write a note or annotation which, when saved, will be located at the current 
open text topic. The presence of an annotation is indicated by a paper clip icon fixed at the 
heading of the topic. Until it is removed, this annotation can be opened by clicking the paper clip 
icon with the mouse at any time. You may wish to use an Annotation in conjunction with a 
Bookmark. 

• Bookmark A Bookmark is a way to mark a place you wish to return to later. When you select 
Define... from the Bookmark menu, a dialog box will appear which allows you to place a reference 
point, called a Bookmark, at the open text entry. The title of the Bookmark will be the same as the entry 
title unless you wish to change it. If you have defined Bookmarks previously, the menu will also display 
the first nine of these. If more than nine have been saved, select More at the bottom of the Bookmark 
menu. A dialog box will enable you to access any of the previously defined Bookmarks. 

• Help Selecting Contents from the Help menu enables you to access the on-line Help file. Selecting 
About Viewer... displays copyright and version information. 

 
Copying a Topic 
In order to copy text from a topic, select the Copy... function from the Edit menu at the top of the 
workspace. When you select Copy, a dialog box will appear which contains all of the text within that topic. 
You have the ability to add to, to delete from, or to accept all of the text for copying. When you are finished 
editing this text, select Copy to copy the text to the Clipboard. The Clipboard can then be pasted into any 
word processing application or into an Annotation. If you do not wish to copy the text to the Clipboard, 
select Cancel. A copyright notice will be appended to the selected text (refer to Your Copyright 
Responsibilities). 
 
Printing a Topic 
In order to be able to print a topic, select Print Topic from the File pulldown  menu. The current topic 
will be printed in its entirety to the printer you have set up on your system. If you wish to set up a printer or 
modify your printer selection, select Print Setup... from the File menu. 
 
Using Keyboard Shortcuts to Perform Functions 
It is possible to use keyboard characters to perform most of the functions available through the use of a 
mouse.  See the Help/Contents for a list of keyboard techniques you can use to perform other mouse 
functions. 
 
PERFORMING SEARCHES 
Using the Alphabetical Listings 
Filmography. If you already know the film title you are looking for, you can use the alphabetical listings 
in the Filmography to find the topic which discusses the film: 
1. Open the Thanhouser Films section of the CD-ROM. 
2. Click on the Filmography button at the top of the workspace. 
3. Click on the letter in the alphabet corresponding to the first letter of the title. 
4. A listing of the films beginning with that letter will appear. 
5. Select the title from the list. 
 
Biographies. If you already know the name of the person you are looking for, you can use the alphabetical 
listings in the Biographies volume to find the biographical topic for that name: 
1. Open the Thanhouser Films section of the CD-ROM. 
2. Click on the Biographies button at the top of the workspace. 
3. Click on the letter in the alphabet corresponding to the first letter of the name. 
4. A listing of biographies beginning with that letter will appear. 
5. Select the name from the list. 
 
Using an Index 
Each of the volumes in the Thanhouser Films section of the CD-ROM has a separate index of pre-set 
topics: 



Thanhouser Films: An Encyclopedia and History CD-ROM 

 - 7 - 

1. Click on the Index button at the top of the workspace. 
2. Select the volume you wish under Current Index:. 
3.  Type or highlight the entry you wish to access. Double click on the entry or select the OK button 

within the dialog box to jump to this topic. 
 

NOTE 
Because all the index entries are pre-set, you will only be able to access the entries which 
are listed in that Index. 
 

If there is more than one listing for an indexed entry, a Topics Indexed dialog box will appear which lists 
all the entries. Highlight the entry you wish to view and either double click it or click the Go To button 
within the dialog box. 
 
The Topics Indexed dialog box will remain on the screen until you either remove it, minimize it, or return 
to the main Index. To minimize the dialog box, click on the icon at the upper left of the dialog box and 
select Minimize, or select the "_ " character at the upper right of the box. 
 
Search 
The Search button is a powerful tool which allows you to customize a search for data in any or all of the 
volumes comprising the Thanhouser Films section of the CD-ROM. In addition to finding entries which are 
pre-set, you can locate all occurrences of words or phrases you are interested in. Click on the Search 
button at the top of the workspace. A dialog box will appear: 
• Searching by Word or Phrase. In the Search by Word area of the dialog box, type the word or 

phrase you are looking for. For example, if you are looking for "Baseball and Bloomers" in all of the 
Topic Groups,  you will locate eight entries.  If you type a phrase, the Search function assumes that 
you are looking for all occurrences of each word. It will locate the words in conjunction with each 
other, but it will also locate the words as they occur singly. If you want to search for a particular 
phrase, enclose it in quotes. For example, If you are looking for Players Club references, use "Players 
Club." This will avoid a lengthy list of topics containing "players" and "club" as individual entries. 

• Topic Groups. In the Search In: area, you can specify your search to be through any or all of the 
Topic Groups. These groups consist of the Narrative History, Filmography, Biographies, Appendix, 
Film Titles and Biography Entries. Select All Topic Groups to search all topics, Selected Topic 
Groups to restrict your search, or Current Topic Only for the currently topic. 

• Options. The Options... button at the right of the box allows you to restrict the search to Topic 
Titles Only and/or the List of Previous Topics Found.  

• Using Search Operators. As a refinement, you can use the search operators AND, OR, NOT, and 
NEAR to specify your search criteria. Choose the Hints...  button in the Search dialog box for a quick 
discussion on how to use search operators. 

• Search Results. When you execute a search, a Search Results dialog box will appear which lists all 
topics where there are occurrences of the word, words, or phrase you asked for. The program will save 
the results of the last ten searches. They are listed under the Search by Word dialog box. If a word 
or phrase occurs more than once within a topic, the search results list will signal this by activating the 
Next Match and Previous Match buttons. These buttons will not be active if there is only one 
occurrence of the results within the topic entry.  You can look through the search list by highlighting 
each entry in turn. Double click the entry or select the Go To button in the dialog box to view the 
entry you have highlighted. The Search Results dialog box will remain visible, so that you can 
continue to browse through the search results.  

 
A Sample Search 
For discussion,  say you are interested in  W. Ray Johnston, who worked as a financial manager and actor 
with the Thanhouser Company from 1913-17.  You might want to search for Johnston.  However, that 
search would also locate anyone named Johnston in addition to the W. Ray Johnston you were looking for. 
If you were to look in the Biographies alphabetical index under "J," you would find two entries for 
Johnston:   William  Ray and Agnes. Were they connected in some way? You could find out by scanning 
their biographies. 
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You could restrict the search specifically to "W. Ray Johnston."  You would find many entries.  You might 
have noted from his biography that William Ray Johnston was married to Violet, sister of Charles Hite, 
who ran the Thanhouser Company from 1912-14.  This might cause you to initiate follow-on searches.  
Some entries for William Ray Johnston will not be useful.  But in order to determine which entries are of 
real interest to you, you will have to browse through the results list generated by your Search. 
 
Creating Bookmarks 
A bookmark is a useful way of quickly returning to a topic you may want to revisit.  It is particularly handy 
for marking topics you want to save from a Search Results list.  In order to create a Bookmark, select 
Define... from the Bookmark pulldown menu.  The first nine Bookmarks you define will appear 
subsequently within the popup menu itself.   
 
When you select Define..., a dialog box will appear which enables you to OK the current location as a new 
Bookmark or to Delete previously defined Bookmarks. 
 
To go to an already defined Bookmark, click on Bookmark and highlight and select one of the topics 1 - 9 
which appear in the popup menu.  If more than nine Bookmarks have already been defined, highlight the 
word More... which appears at the bottom of the menu.   A dialog box will appear which lists all the 
Bookmarks.  Highlight and select the one you want to visit, either by double clicking it or by selecting the 
Go To button in the box. 
 
Creating Annotations 
Annotations are especially useful in conjunction with a Bookmark to write a note to yourself or copy a 
relevant text to be stored at that location.  Under the Edit menu at the top of the workspace, select 
Annotate....  An empty dialog box will appear in which you can Paste from the Clipboard or write 
information to be used at that location later.  
 
If you are satisfied with the Annotation, you can Save it, or you can Delete an existing Annotation.  When 
you Save it, the Annotation dialog box disappears, and a colored paper clip icon will be visible at the 
heading of the current topic.  Clicking the paper clip icon will bring up the annotation you have saved at 
this location.  After saving an Annotation, the logical next step is to create a Bookmark at the same 
location, so that you can retrieve the information you have left there. 
 
YOUR COPYRIGHT RESPONSIBILITIES 
The Thanhouser Films CD-ROM contains copyrighted materials that are licensed to you, the end user, for 
your personal use and are subject to the terms of the enclosed end-user license agreement. You must treat 
this software and its contents like any other copyrighted material, for example a book or musical recording. 
Any other use, duplication, or distribution of this product or its contempts may violate applicable US or 
international copyright laws, and may subject you to prosecution under penalty of law.  
 
Copy Command Usage The Thanhouser Films CD-ROM includes a copy command feature that allows 
you to highlight and copy text and images to the Clipboard in Microsoft Windows. This feature is provided 
for your personal use of this product. For example, you may wish to copy information on a certain topic to 
an electronic file to make a research file for your future reference, or you may wish to print out an article to 
read later when you are away from your computer. Material from this CD-ROM may be copied and used 
for scholarly research and academic publication with the requirement to include credit to the source and 
author. However, copyright law does not allow you, for example, to copy an article or media for 
commercial publication or posting on to a computer bulletin board or a web-site for public access. These 
examples are only illustrative, and not meant to summarize applicable law. See the Licence Agreement on 
the inside cover of this Users Guide for copyright restrictions.  
 
IMAGES, CLIPS, AND POSTERS 
The three remaining programs in the Thanhouser Company program group installed by the setup program 
consist of Thanhouser Images, Thanhouser, Clips, and Thanhouser Posters. After launching any of these 
programs, click on the Kudo title page in order to view what you have selected. 
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For all of these programs the default drive on which the information resides is assumed to be “C”.  If your 
CD-ROM drive is different ( for example, "D"), you will be requested to enter the correct identification for 
your CD-ROM. 
 
Thanhouser Images 
The Thanhouser Images program on the CD contains 429 black and white photographs and images taken 
from Thanhouser films, private and public collections, advertisements, magazines, and other related 
sources. These images are displayed in the Narrative History, Filmography, or Biography volume of the 
book, but  in a smaller reference size.  Thanhouser Images makes available these photographs in a higher 
quality .tif format, 4" x 6", scanned at 75 dpi.  For each image there is a caption which you can access by 
clicking on an image and then clicking on the INFO button.  
 
There are three views which you can use to look at images:  1)The Small Gallery view, which shows the 
maximum number of images on the screen, 2) The Gallery view, which reduces the number of images and 
displays the image reference number, and 3) the List view, which displays the single image you have 
selected along with information and a caption regarding the image. These three views are available to you 
by using the three buttons at the upper left of the workspace or by selecting one of the three choices under 
the View pulldown menu at the top of the workspace. In addition, each image can be viewed enlarged by 
clicking on the image and then selecting the Preview command under the Image pulldown menu at the 
top of the workspace. Double clicking on any of these images will launch any available editing tools on 
your system which can edit .tif format files. You can use commercially available software to modify and 
print these images  (e.g., Adobe Photoshop or Corel PhotoPaint: exactly which tool depends on the 
software installed on your system. These tools are not provided with this CD-ROM). 
 
In order to locate in the Images section of the CD-ROM a photo or illustration you find in any of the three 
volumes of the Thanhouser Films section, note the reference name (example, A-1-4) in the caption of the 
photo.  When you enter the Images section, you can use the Find button to locate this photo by name or the 
caption associated with that image. A three-sectioned dialogue box will appear allowing you to specify the 
search parameters. Photo captions are accessed under the Notes reference. 
 
When you want to return to the full gallery of possible photos, click on the Find All command under the 
Image pulldown menu at the top of the workspace or click the Find button, and look for Everything.   
 
Kudo has a help feature which explains how to search for a specific photo by name or how to find the 
photos that have a specific actor or film name in the note (description). A user can also sort the images in a 
variety of ways: name, notes, etc.  
 
Thanhouser Clips 
This section contains 32 silent clips from Thanhouser films. The gallery view of clips does not allow you to 
view images from the clips themselves. In order to determine which window you are looking at, click on a 
window and then click on the Info button. Or you can select the List command from the View pulldown 
menu at the top of the workspace. The film name for each clip is listed next to the item in the note section.  
If you double click on the item, your system's video driver will allow you to play the silent video clip you 
have selected. To do this, click the appropriate control on the media player panel which appears as the clip 
becomes ready to run. 
 
Thanhouser Posters 
This section allows you to view 19 high resolution Thanhouser posters in full color. Double clicking on any 
of these posters will bring up a large view of the poster using the Windows Paintbrush tool. Posters, 
including modifications, can be printed or saved to another directory as .bmp files. Modifications cannot, 
however, be saved to the CD-ROM, for obvious reasons. 


